
		
			
					









						
	
								
										
											
														PDFill PDF Editor
	
														Buy PDF Editor
	
														Free PDF Editor
	
														Free PDF Tools
	
														Free PDF Writer
	
														Free Image Writer
	
														Download
	
														Information
	
														Example
	
														Quick Start
	
														What is New
	
                                      
                                      Support
	
                                      FAQs
	
                                      About us
	
                                      Awards & Reviews
	
                                      PDF Consulting


									


							

 

	
	
		Frequently Asked Questions:

			
            If you have 
			problems, click 
			
			here to download the 
			latest PDFill version. 
			When reinstalling, 
			right-click the exe and select "Run as Administrator" to install.

		    
		    1. Questions about the 
			
			PDFill License
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			when you download and 
			install
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			you open a PDF

            

            4. Problems
			when 
			you edit a PDF 
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			you save the editing into a new PDF
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			1. Questions 
			about the
			PDFill License

			
        	
			What is 
			PDFill License?
	
			
			The license for PDFill PDF Editor is lifetime. You 
			have free upgrades as long as you keep the registration code.
			Please print into the hardcopy to keep it. See
            
			License Agreement.

	
			I lost my 
            code. Do I need to buy the software again?
	
			
			If you purchased PDFill Editor in the 
			365 days, 
			
			look up your code using the exact email you used when you 
			purchased the product. 

			If it has been longer than 365 days, PDFill will not be able to 
			resend you the code (see
            the License Agreement) 
			and you have to buy PDFill again.

	
			How do I 
			register PDFill PDF Editor?
	
			Please 
            see the steps on
			How to register PDFill PDF Editor.

	
			
			The registration code 
			doesn't work even if I do the COPY and PASTE
	
			Right Click 
			"PDFill PDF Editor" from Desktop and select "Run as Administrator" 
			and then do the registration.

	
			How many computers can I activate for each 
license? 
	
			 For each license, you can only 
activate on two different 
machines 
at the same time. 

	
			
			How can I transfer my license on a new computer?
	
If you want 
to install the software on a different computer, you must first deactivate the 
license on your current computer. 
				Choose Help Menu => 
Enter Registration Code => Deactivate.
	
			It 
says that you have installed on too many computers.
	
You have to 
deactivate the other computers by yourself. We offer NO SUPPORT to deactivate on 
our server side. See

License Agreement.  
If you cannot do that, we suggest that you buy a new license using a new email.
	
			My Email 
			has changed. Do I need to change my code?
	
			No. Please 
			still use the old email to register your PDFill. PDFill doesn't send 
			email to your email account.
	
			Do I need 
			to pay for PDFill PDF & Image Writer or PDFill PDF Tools?
	
			No!
            PDFill PDF & Image 
            Writer and 
            
            PDFill PDF Tools are included inside the FREE trial version of 
            PDFill PDF Editor. See
            the License Agreement.

	
			Do I need 
            a PayPal account to buy PDFill PDF Editor?
	
			No. If you 
            don't have a PayPal account, you can STILL use your credit card.  To 
            do so, please click the PayPal icon, then click the option "Pay 
			with a debit or credit card". 

	
			PayPal 
			Link Stops working
	
			From 
			Brower, Safety=>Deleting Browsing History. Restart computer to try 
			again.

	
			I didn't get my 
            registration code after I paid 
	
			Your registration code 
			should be delivered to your e-mail account or web browser 
			immediately.  If you do not receive your code after 30 minutes, 
			check Spam/Trash Folder first. You can
			look up your 
			code or email
			
			sale@PDFill.com. We will process your email within 24 hours.

	
			Can I just 
            buy one license to use PDFill PDF Editor for both  my home computer 
            and my company computer?
	
			No. Your 
            company and your home represent two users. You need to buy a copy of 
            the software for each of them.    

	
			The registration code 
            is successful but it requires registration every time when PDFill 
            Starts.
	
			Please 
            upgrade to 9.0 or later.
            Please 
            turn off any spyware on your computer, so the code can be 
            successfully written into your registry. 



        2. Problem when you download 
        and install PDFill

			
        	
			Problem to 
			UNINSTALL or Install of PDFill Package
	
			Follow the steps in in 
			the Microsoft 
			Program Install and Uninstall Troubleshooter
			
			
Check Folder 
			"C:\Windows\Installer" to have full control permission to the user 
			group "Everyone".

	
			PDFill cannot run properly
	
			You must turn off your 
			
			Windows Firewall and any Antivirus Software first.  Then, run
			
			Windows Update and restart your computer.

			

			1. Uninstall PDFill First 
			from Control Panel. 

			2. From Start Menu, Select "Run" and then type "RegEdit" to Delete the registry file under: HKEY_CURRENT_USER\Software\PlotSoft\. 

            3. Delete all files under C:\Program Files\PlotSoft\

			4. Download
			the latest
			PDFill 
			again. When reinstalling, right-click the exe and select "Run as 
			Administrator" to install. 

			

			If you still have problem, Restart your computer and Right Click "PDFill PDF Editor" from 
			Desktop and select "Run as Administrator".

			You can disable UAC, reboot, reinstall 
			and activate PDFill, then enable UAC.

	
			Problem comes after 
			Win7/8 was upgraded into Win 10
	
			We strongly 
			suggest to RESET your PC since
			
			the upgrade is not perfect. See
			
			how to reset Win 10. After Reset, reinstall
			PDFill  
			and other programs. 

			
	
			Install PDFill 
            Silently 
	
			Get PDFill_X32.msi 
            from 
			here. 
            Use Command: msiexec.exe /quiet /i PDFill_X32.msi

	
			Install GhostScript 
            Silently 
	
			Get GS_Lite.msi 
            from
			here. 
            Use Command: msiexec.exe /quiet /i GS_Lite.msi

	
			Cabinet file is 
			corrupted or missing.
	
			Clean all the Internet Temp Files 
			from Internet Explorer: Safety=>Delete Browsing History.

	
			How can I open PDF 
            Files inside Internet Explorer?
	
			Adobe Reader=> Edit => 
            Preferences => Internet => Display PDF in Browser

	
			Chrome or Firefox 
			Browser does not support all PDF capabilities.
	
			Configure the browser to use the Adobe PDF 
			plug-in. See
			
			here.

	
			Does PDFill support 
			USB jump drive?	
			No. PDFill is not 
			portable and cannot be installed on a USB jump drive. 
	
			Installation stops at 
			"Extracting the Main Application files"
	
			Turn off your Firewall 
			and any Antivirus software. Then, try
			32-Bit MSI 
			package or 
			64-Bit MSI package.



        3. Problem when  opening a 
        PDF file

			
								
									
									PDFill cannot 
									read my PDF; The Page is not displayed 
									correctly inside PDFill; Problem to read all of the PDF 
									pages.
	
									
									There are 3 
									ways:

									1. Open your PDF file using Adobe Reader, 
									Save As 
									to get a new PDF; 

									2. Open your PDF 
									file using Adobe Reader, print it using 
									
														PDFill PDF & Image Writer 
									to get a new PDF; 

									3. Use PDFill PDF Editor 
									=>
									
									
									
									
									PDF Optimizer 
									to get a new optimized PDF.

									
									Then, open the new PDF file 
									inside PDFill PDF Editor.

	
									
			PDFill is slow on some PDF or PDF Page 
									appears blurry
	
									
									Select Menu 
			Format => PDFill Options => System Tab =>
									Convert PDF Page into Image 
									=> Change DPI

	
									The old 
									project file (PFL) is corrupted and cannot 
									be read into PDFill. 	
									Please reopen 
									the original PDF using PDFill PDF Editor, 
									then, Edit 
            Menu=> Copy Edited Objects from Another Project or Copy 
			PDF Form Fields from Another Project.
	
									If this 
									message is not eventually replaced by the 
									proper contents of the document.	
									Certain PDF 
									files (dynamic XFA forms) created in Adobe 
									LiveCycle can only be opened in Adobe Reader 
									and Adobe Acrobat. See
									
									details.


        					4. Problem when editing a PDF

			
        	
			My original PDF Form 
			inside Adobe Reader 11 is not Savable.	
			Open this PDF inside 
			PDFill PDF Editor, Edit Menu=>Make Entire Form Field Editable, then 
			save into a new PDF.
	
			How can I copy the 
			original PDF Field?	
			The original form 
			field cannot be copied directly. Edit menu=>Make Entire Original 
			form field Editable, then select and copy.
	
			When I fill out a form 
			inside PDFill, the field I just filled in does not show up when I 
			move to another field.	
			Click the Refresh 
			button on the view bar. If that does not work, change the font name 
			to Arial or Times New Roman.
	
			Can I convert 
			non-interactive paper forms into interactive forms totally automatically?
	
			No. Even the 
			pricier Adobe Acrobat cant do this. You will need to add 
			interactive form fields one-by-one or type text into the PDF file. 
			You can use the PDF Form Field Recognition by Clicking.

	
			How do I tie several 
            Radio Buttons together so that one and only one is checked and one 
            of them is required?
	
			Use the same form 
			field name for the group of radio buttons, but use different values 
			for each button.

	
			How can I adjust the 
			margins of the PDF page?
	
			If you need more 
            margin, please use Free
            PDFill PDF Tools 
            to Reformat the PDF page. If you need less margin, please use the 
            Rotate/Crop tool.

	
			How can I fix the form 
            so that the user can only fill the form fields?
	
			PDFill Options =>
			View Tab => Simple GUI for PDF Form Filler.

	
			How can I see the name 
			of each form field?
	
			PDFill Options =>
			PDF Form Tab => Show 
            Form Name.

	
									
									PDFill's Tab Key Stops working.
	
									
									View Menu=>
									Reset Toolbars.

	
			Can PDFill edit the 
            static text inside PDF?
	
			Not directly. There 
			are two ways:

			1. Use the 
			
			Whiteout function to cover the original text and then retype 
			over it.

			2. Use 
			PDF 
			Eraser to remove the original text to get a new PDF. 
			Then, open this new PDF to type new text. 

	
									
									Can I search 
									inside PDFill?
	
									
									NO. Please 
									open your original PDF inside Adobe Reader 
									and search your keyword.

	
									
									Can PDFill 
									convert PDF into Word or Excel?
	
									
									NO. Please use 
									Adobe Reader => File Menu=>Save a Text. 
									Or, Document Menu => Extract Text

	
									
									Scanner 
									"Server Busy" Problem
	
									
									Please use
		PDFill 10 or later.  
		Use the following options:

		PDFill PDF Editor: File Menu => Import Image from Scanner => 
									Scan using WIA;
		PDFill PDF Tools: Scan into Image or PDF => Scanning Method =>
									WIA



        5. Problem when Saving the 
        editing into a new PDF

			
        	
			Print only the filled data onto 
			the Preprinted Paper.	
			
            
            Save PDF Options =>
			Output Options => Hide 
						the original PDF Page to Print the filling form data Only.
			If 
						you scan a paper form to fill, you need to make a copy 
			of the project file and then delete the scanned image. 
	
			The PDF form that I 
			created cannot be filled using Adobe Reader.
	
			Make sure that you use
			PDF Form Maker 
			to create PDF Form. Please use
			Text Form 
			Field instead of PDF Filler's
			Singleline 
			Text or PDF Commenting's
			TextBox.  
			If you use PDF Filler or PDF commenting, there will be no 
			interactive PDF Form Fields. 

	
                        
			Problem to print the 
						filled PDF; The saved PDF is opened by 
						PDFill  instead of Adobe Reader.	
                        Uninstall and reinstall 
						Adobe Reader from
						here 
						so that Adobe Reader is the default PDF viewer.
	
			
			I used 
			PDFill to create an interactive fill-in form. 
			Can my client fill and SAVE 
			the filling into a new PDF using Adobe Reader?
	
			Yes, please ask your 
			client to install 
			Adobe 
			Reader XI to save the filling into a new PDF directly.  You 
			can also 
			see 
			alternate 
			solutions.

	
                        I don't 
						want to print the PDF and sign on paper, how can I sign 
						my PDF using digital signature on computer?
	
                        There are 
						a few ways: (1) Scan your signature from paper into an 
						image and
						
						insert image into PDF; (2) Use PDF Comment's
						
						Pencil Tool or PDF Drawing's
						
						Curve Tool to draw your signature; (3) Use
						PDF Ink 
						Annotator to draw on PDF on PC with mouse or on 
						Tablet PC using the pen input; (4) Add a
						
						Digital Signature (PFX file) into PDF Document; (5) 
						Add a Digital 
						Signature Form Field and ask your client to use the 
						latest free 
						Adobe Reader to sign.

	
																			
																			
																			Length 
																			cannot 
																			be 
																			less 
																			than 
																			zero. 
																			Parameter 
																			name: 
																			length

																			
																			
																			Java.Lang 
																			String 
																			Index 
																			Out 
																			Of 
																			Bounds 
																			Exception
	
			Some Font 
            name is empty and must be replaced by the most common fonts.

			1. Download
			the latest
			PDFill. When reinstalling, right-click the exe and select "Run as 
			Administrator" to install. 

            2. Edit menu=> Change Text Object's Font Name=>Select Times New 
            Roman to replace all text fonts=> Click OK

	
			The filling data doesnt appear on the form. The data disappears after 
			a few seconds or not all of the data is saved into the form.
	
			Try this 
			first: From PDF Saving Options, select Flattening. 

			If that does 
			not work, choose Make Entire Original Fields Editable from the 
			edit menu.

	
			I don't 
            like the font name, size or color inside the PDF Form fields.
	
			
            From Menu Edit > 
            Make Current Original Form 
            Field Editable

	
			The Submit 
			Form button produces an error message Cannot handle context type: 
			text/html
	
			Save your 
			PDF form to your web server instead of your local computer.

	
			There is a watermark 
			printed on every new PDF page after I buy PDFill PDF Editor.
	
			After you buy PDFill 
			PDF Editor, you must
            
			register PDFill first !!!

            Please save your filling project 
            into a PFL file before you buy PDFill. 

			After
            you register 
            PDFill, resume the saved PFL file and save it into a new PDF. 
            

			The best way is to reopen your original PDF that has no watermark and fill again.  You can also reopen the original PDF inside PDFill, then Edit 
            Menu => Copy Edited Objects from Another Project or Copy 
			PDF Form Fields from Another Project.

			You may use
			PDF 
			Eraser to remove the watermark to get a new PDF. 
            

	
			
            The commenting text 
            style inside PDFill is different than that in the PDF Output. 
            
	
			
            Note: Adobe Reader will use its default font for PDF Commenting 
        Text. So, the text style inside PDFill will be different than that 
        inside Adobe Reader.
        To exactly control  the text style (font encode, font name, font size 
        and font style) in the PDF output, please use the
            Single Line Text or Multiple Line Text. 
            You can convert all the Commenting text into Multiple Line Text from 
            Edit Menu.

	
			Problem with language encoding and font.
	
			From PDFill Options, 
            select your language coding and then your desired font. You may play 
            with several fonts to see if it works. 
            If you have problem, please open a new blank PDF project, test your 
            language coding and font, then, save into a new PDF to see if it 
            works.  If this works, please open your original PDF inside 
            adobe reader, print it into PDFill PDF Writer to get a new PDF, open 
            this new PDF inside PDFill.

	
			The 
			new PDF Form Field doesn't show in the PDF with PDF/A Mode
			.
	
			Please open your original PDF inside adobe reader, print it into 
			PDFill PDF 
			Writer to get a new PDF, open this new PDF inside PDFill.  
			Use Edit 
            Menu => Copy Edited Objects from Another Project. 

	
			How can I change the color of the PDF Form Field inside Adobe 
			Reader?
	
			Adobe Reader => Preference =>Forms=>Fields Highlight Color

	
			Can PDFill PDF Editor reduce or optimize the size of the PDF file?
	
			These may work: (1) 
			Document Menu => PDF 
			Optimizer; (2) Open your PDF inside Adobe Reader, Print into
			PDFill PDF 
			Writer with
			the Screen Option of 
			PDF 
			Optimization. (3) Convert your 
			PDF into 
			Images with 72 dpi. Then, convert
			Images 
			back to PDF.
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